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@ Legal notice

Copyright and trademark information relating to this product release.
Copyright © 2000-2017 SDL Group.

SDL Group means SDL PLC. and its subsidiaries and affiliates. All intellectual property rights contained
herein are the sole and exclusive rights of SDL Group. All references to SDL or SDL Group shall mean SDL
PLC. and its subsidiaries and affiliates details of which can be obtained upon written request.

All rights reserved. Unless explicitly stated otherwise, all intellectual property rights including those in
copyright in the content of this website and documentation are owned by or controlled for these
purposes by SDL Group. Except as otherwise expressly permitted hereunder or in accordance with
copyright legislation, the content of this site, and/or the documentation may not be copied, reproduced,
republished, downloaded, posted, broadcast or transmitted in any way without the express written
permission of SDL.

SDL Trados Studio is a registered trademark of SDL Group. All other trademarks are the property of their
respective owners. The names of other companies and products mentioned herein may be the trade-
marks of their respective owners. Unless stated to the contrary, no association with any other company
or product is intended or should be inferred.

This product may include open source or similar third-party software, details of which can be found by
clicking the following link: Acknowledgments on page 0.

Although SDL Group takes all reasonable measures to provide accurate and comprehensive information
about the product, this information is provided as-is and all warranties, conditions or other terms
concerning the documentation whether express or implied by statute, common law or otherwise
(including those relating to satisfactory quality and fitness for purposes) are excluded to the extent
permitted by law.

To the maximum extent permitted by law, SDL Group shall not be liable in contract, tort (including
negligence or breach of statutory duty) or otherwise for any loss, injury, claim liability or damage of any
kind or arising out of, or in connection with, the use or performance of the Software Documentation
even if such losses and/or damages were foreseen, foreseeable or known, for: (a) loss of, damage to or
corruption of data, (b) economic loss, (c) loss of actual or anticipated profits, (d) loss of business revenue,
(e) loss of anticipated savings, (f) loss of business, (g) loss of opportunity, (h) loss of goodwill, or (i) any
indirect, special, incidental or consequential loss or damage howsoever caused.

All Third Party Software is licensed "as is." Licensor makes no warranties, express, implied, statutory or
otherwise with respect to the Third Party Software, and expressly disclaims all implied warranties of
non-infringement, merchantability and fitness for a particular purpose. In no event will Licensor be
liable for any damages, including loss of data, lost profits, cost of cover or other special, incidental,
consequential, direct, actual, general or indirect damages arising from the use of the Third Party
Software or accompanying materials, however caused and on any theory of liability. This limitation
will apply even if Licensor has been advised of the possibility of such damage. The parties
acknowledge that this is a reasonable allocation of risk.

Information in this documentation, including any URL and other Internet Web site references, is subject
to change without notice. Without limiting the rights under copyright, no part of this may be reproduced,
stored in or introduced into a retrieval system, or transmitted in any form or by any means (electronic,
mechanical, photocopying, recording, or otherwise), or for any purpose, without the express written
permission of SDL Group.
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@ Introducing SDL Trados Studio 2017

This chapter gives you an overview the of SDL Trados Studio client installation procedure and the Trados
Studio 2017 system.
Sections include:

e About this Guide

e Introducing SDL Trados Studio 2015

e Studio Editions

e Upgrade and Compeatibility Information

About this guide

This guide describes how to install and license SDL Trados Studio 2017 desktop application.

This guide does NOT cover:
e |Installing the server components of SDL Trados Studio 2017.
e |Installing the SDL MultiTerm 2017 application.
e Converting or upgrading existing translation resources to use with SDL Trados Studio 2017.
e Using SDL Trados Studio 2017.

Audience for this guide

This guide is for anyone who is installing any edition of SDL Trados Studio on a personal computer.

Related Documentation

e SDL Trados Studio 2017 SR1 Migration Guide - contains information about converting or upgrading
existing translation resources from SDL Trados 2007 and SDLX so that you can work with them in
SDL Trados Studio 2017 SRT.

e Trados GroupShare 2017 Installation Guide - contains information about installing the server
components of SDL Trados Studio 2017 and upgrading server-based translation memories from
Trados Studio 2009 to the 2017 SR1 format.

e SDL Trados Studio Help - contains information about using SDL Trados Studio 2017 SR1.

e Translating and Reviewing Documents Quick Start Guide - contains information for translators and
reviewers. It focuses on how to translate and review files.

® Project Management Quick Start Guide - contains information for project managers. It focuses on
the project lifecycle.

e Translation Memory Management Quick Start Guide - contains information for users who create
and maintain translation memories.

e SDL MultiTerm 2017 Installation Guide - contains information about installing SDL MultiTerm 2017.
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About SDL Trados Studio

SDL Trados Studio is an integrated environment that enables translation teams to share translation
tools, resources and project files.

Resources such as translation memories can be shared over an intranet or over the Internet.

You can also use Trados Studio as a single-user tool where the Trados Studio software and translation
memories are located on your computer and there is no interaction with translation memories or projects
over an intranet or the Internet. Single-users can open and work with project packages created in

other Trados Studio installations.

About SDL Trados Studio 2017

SDL Trados Studio 2017 contains tools that enable you to:
e (Create and maintain local and server-based translation memories.
e (reate and manage translation projects.
e Open documents and translate them.
e Open server-based and local translation memories and apply them to documents.
e Open local and server-based termbases and apply them to documents.
e Update translation memories and termbases during translation.
e Align existing translated documents to generate translation memory content.
In a setup that includes server components, Trados Studio client communicates with server components

through an intranet (through a LAN or WAN) or through the Internet using SDL Trados GroupShare.
SDL Trados GroupShare includes the following components:

® Project Server
e TM Server

e MultiTerm Server

Trial License

SDL Trados Studio 2017 includes a 30 days trial license.

At the end of 30 days, purchase a license if you want to continue using Trados Studio.

Trados Studio Editions

The following editions of SDL Trados Studio 2017 are available:
e Professional
e Freelance
e Starter

® Express

Installation Guide 3



@ Introducing SDL Trados Studio 2017

e Workgroup

SDL Trados Studio Professional

SDL Trados Studio Professional is the complete package that includes all available features.

If you are also working with SDL GroupShare the server component of Trados Studio, this edition gives
you project manager functionality designed for use in GroupShare environments.

Note: If you are translating for a regulated industry, a separate license enables you to create regulator
review bundles. These bundles contain a specific collection of documents needed by the regulator for
review.

Regulated Industries add-on

If you are translating for a regulated industry, you can purchase an additional license that enables you to
create regulator review bundles.

These bundles contain a specific collection of documents needed by the regulator for review. This
license is an add-on for a Professional edition of Studio.

Translation Quality Assessment add-on

You can also add the TQA license to your Studio Professional edition.

This enables you to create TQA configurations for your projects in order to measure the quality of a
translation using custom quality criteria.

SDL Trados Studio Freelance

SDL Trados Studio Freelance is limited in the following ways:

e You can only work with five languages. To change your language selection at a later point, return
the license, uninstall and reinstall, then activate your license again. This will take you back to the
language selection window.

® You can use AutoSuggest dictionaries but you cannot create them. If you want to create AutoSug-
gest dictionaries, a separate AutoSuggest license enables you to do this.

® You cannot use SDL Trados Studio Freelance on a computer that is part of a domain-based corporate
network.

® You can open and work with project packages, but you cannot create them.

® You can add and edit translation quality assessments, but you cannot create a Translation Quality
Assessment configuration for a project.

® You cannot create custom task sequences.
® You cannot apply PerfectMatch to project files.

® You cannot publish GroupShare server-based projects.
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SDL Trados Studio Starter and SDL Trados Studio
Express

SDL Trados Studio Starter and SDL Trados Studio Express both have similar functionality to Freelance.

What you can do in Starter and Express depends on which workflow you are using. The following list
shows the key tasks that you can perform in each workflow. Express also allows you to run Studio as part
of a domain-based corporate network and have use of an unlimited number of languages.

What you can do in Starter and Express

Single-File Translation Workflow in Starter

You can perform the following actions when you are in a single-file translation workflow. A single-file
translation workflow occurs when you open a single file for translation using the Translate Single
Document command.

Note: This workflow is not available in Express.

e Open asingle file for translation.
e C(Create file-based translation memories.

e Add assingle file-based translation memory to use during translation. The size of the translation
memory is specified by your license.

e Add and remove termbases for translation.

e Edit translation units in a translation memory during translation.

e Edit translation memory settings.

e You can import and export translation memory data to or from a translation memory.
e Update the translation memory during translation.

® Generate a translated document.

Project Package Translation: Offline Workflow in Starter and Express

® You can perform the following actions when you are in a project using packages in an offline
workflow:

e Open project packages. In Express, you can only open packages created in an SDL enterprise
product. Enterprise products include WorldServer and TMS.

e Openfiles for translation or review from a project package.

e Disable or enable termbases in the package for translation.

e Disable or enable translation memories in the package for translation.
e Remove AutoSuggest dictionaries in the project for translation.

e Edit translation units in a translation memory during translation.

e Update the translation memory during translation.

® Return completed work in return packages.
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Restrictions in Starter and Express

e The following batch tasks are disabled in Starter: Translation Quality Asessment, Apply Perfect-
Match, Populate Project Translation Memories, Update from Reviewed Target File (Retrofit),
Pre-translate Files, Update Main Translation Memories, Update Project Translation Memories.

e The following batch tasks are disabled in Express: Translation Quality Asessment, Apply Perfect-
Match, Update from Reviewed Target File (Retrofit).

e The Add Files, Add Folders, Add New Folder and Remove Files commands in the Files view are
disabled in both versions.

® You cannot specify custom settings when upgrading translation memories from previous editions
of SDL Trados or SDLX in both versions.

e Translation memory maintenance in the Translation Memories view is disabled in both versions.

e The Align Single File Pair, Align Multiple Files and Open Alignment commands along with the
Alignment view are disabled in both versions.

SDL Trados Studio Workgroup

If you are working with SDL GroupShare, the server component of Studio, the SDL Trados StudioWork-
group edition gives you functionality designed for use in GroupShare environments.

® You can open GroupShare projects.

® You can translate or review documents from GroupShare projects.

Other standard Studio functionality is available with the following limitations:
® You cannot create new projects.
® You cannot publish projects to SDL GroupShare.

® You cannot perform TM maintenance in Translation Memories view in Studio.

Upgrade and Compatibility Information

Information for upgraders

If you currently have a previous version of SDL Trados or SDLX installed, you do not need to uninstall
them before installing SDL Trados Studio 2017.

The new version of the software will be installed side-by-side with previous versions of the software.

If you want to install SDL Trados Studio 2015 and SDL Trados Studio 2017 on the same computer, make
sure that you install the 2015 version first.
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SDL Trados Studio project and package compatibility

All versions of SDL Trados Studio 2017, 2015 and 2014 have the same project and package format.

Translation Memory Compatibility

Software

SDL Trados Studio 2017 can connect to any 2017 and 2015 version of SDL TM Server.

Server-based Translation Memories

You can use server-based translation memories created in SDL TM Server 2017 and SDL TM Server 2015
directly in SDL Trados Studio 2017.

You can use server-based translation memories created in SDLX Server, SDL TM Server 2007 or earlier
versions of this product in Trados Studio 2017 if you first convert them to the current format. To do this,
use the Upgrade Translation Memories wizard in Trados Studio. For more information, see the SDL
Trados Studio 2017 Migration Guide.

Local (File-based) Translation Memories

You can use local translation memories that were created in SDL Trados 2007, SDLX 2007 or earlier
versions of these products in SDL Trados Studio 2017 SR1 if you first convert them to Trados Studio 2017
SR1 format. To do this, use the Upgrade Translation Memories wizard in Trados Studio. For more
information, see the SDL Trados Studio 2017 Migration Guide.

MultiTerm compatibility

Software

SDL Trados Studio 2017 is compatible with any 2017 and 2015 version of SDL MultiTerm Desktop.

Trados Studio 2017 can connect to 2017 and 2015 versions of SDL MultiTerm Server.

Note: Depending on which edition of SDL Trados Studio 2017 you purchased, SDL MultiTerm 2017 may
be included in the purchase. However, it is not installed automatically. If you want to install SDL MultiTerm
2017, you must run the SDL MultiTerm 2017 installer. For more information, see the SDL MultiTerm

2017 Installation Guide.
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Server-based Termbases

You can use server-based termbases that were created in SDL MultiTerm Server 2017 and SDL MultiTerm
Server 2015 directly in SDL Trados Studio 2017.

Local (File-based) Termbases

If you have access to termbases from any version of SDL MultiTerm 2017 and 2015, you can work with
them in SDL Trados Studio 2017.

You can search termbases, insert term translations into documents, add new terms to termbases and
edit or delete termbase entries.

Local termbases created in MultiTerm 2009, SDL MultiTerm 2007 (7.5 and 7.x releases) or MultiTerm iX
(version 6.x) can also be used in SDL Trados Studio 2017, but they must first be converted to Trados Studio
2017 format.

When you select a termbase from a version previous to SDL MultiTerm 2009 SP3/SP4 in SDL Trados
Studio 2017, you are asked if you want the termbase to be converted to SDL MultiTerm 2017 format.
When a termbase is converted, the converted termbase file overwrites the original termbase in the same
location.

Note:

e Once atermbase has been converted to SDL MultiTerm 2017 format, it cannot be reverted to an
earlier format.

e If you want to work with SDL MultiTerm 2009 (1.0, SP1, SP2), SDL MultiTerm 2007 or MultiTerm iX
termbases in SDL Trados Studio 2017 and you also want to be able to open the termbases in the
original MultiTerm application, create copies of the termbases before you open them in SDL Trados
Studio 2017.
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This chapter contains all the information you need to install SDL Trados Studio 2017.
It describes the hardware and software requirements for running Trados Studio 2017 and provides a
step-by-step guide to installing Trados Studio 2017. Sections include:

e System Requirements

e About the Trados Studio 2017 Installer

e |Installing Trados Studio 2017

e Software Updates

e Maintaining your Installation

e What's Next?

Overview

This chapter describes the system requirements and installation steps for SDL Trados Studio 2017.

System Requirements

To install and run SDL Trados Studio 2017 you need:

e A Microsoft Windows-based PC (including Intel-based Apple Mac computers running Windows as
an operating system) with 1 gigahertz (GHz) or higher, 32-bit (x86) or 64-bit (x64) processor and 2 GB
RAM (32-bit) or 4 GB RAM (64-bit).

e A screen resolution of 1280x1024 pixels and 256 colors or higher.
® 2 GB of available disk space to run Studio.
e Upto 2.5 GB of available disk space to run the Studio installer.

For optimum performance on 64-bit operating systems, SDL recommends a recent processor with dual
or multi-core technology, 4GB of RAM and a screen resolution higher than 1280x1024.

To successfully license Trados Studio 2017, it is important that your network adapter is enabled.

Operating Systems

e Trados Studio 2017 runs on the latest build of Windows 10, the latest updated version of Windows
8.1 and the latest service-packed version of Windows 7. Trados Studio 2017 also supports Windows
Server 2016, Windows Server 2012 R2 and Windows Server 2008 R2 to facilitate certain scenarios,
for example where Citrix terminal services are used.

e Studio does not support earlier operating systems such as Windows 8, Windows Vista, Windows XP
and Windows 2003 Server.

e SDL recommends that you use the same operating system as the other users with whom you are
sharing packages as the number of supported languages can vary depending upon the operating
system used.
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Internet Browser

e The new Welcome tab with drag-and-drop capabilities introduced in SDL Trados Studio 2017 is only
available on PCs with Microsoft Internet Explorer 10 or later.

e On PCs with Microsoft Internet Explorer 9 or earlier, the old Welcome tab content is displayed.

Trados Studio Help

The Trados Studio Help buttons are context sensitive and redirect to the online deliverable on theSDL
Documentation Center. This means that to get access to the latest updated help for Trados Studio you
need an Internet connection and one of the following Internet browsers installed:

® Microsoft Internet Explorer 10 and later
e Microsoft Edge

® Google Chrome (latest version)

e Mozilla Firefox (latest version)

e Safari 7 and later

If you need to consult the full product documentation in a location with no Internet access, you can
download the WebHelp documentation deliverable, a ZIP file containing all the documentation as static
Web pages.

To download the ZIP file, access the following link: SDL Trados Studio 2017 full documentation as
WebHelp deliverable. Unpack this ZIP file in a location of your choosing and open index.html in an
Internet browser.

Please note that the documentation may be subject to change after the product has been released. The
live documentation resource at https://docs.sdl.com/ SDLTradosStudio2017 is always the most
up-to-date resource.

Digital Certificate Requirements

All SDL Trados Studio code and installer files are digitally signed.

Make sure your list of approved root certificates is up-to-date and includes the root certificate from the
Certification Authority that generates SDL's code signing certificate. At the time of writing, Studio require
DigiCert Assured ID Root CA and DigiCert Assured ID Code Signing CA-1.

e For computers with access to the Internet, go to https://www.digicert.com and add the new root
certificate to your Trusted Root Certification Authorities certificate store. This is only available for
computers running on operating systems supported by Microsoft (Windows Vista or later).

e For computers in a locked down corporate environment without access to the Internet, follow the
instructions available at https://technet.microsoft.com/library/dn265983.aspx You can also
download the specific root certificates directly from
https://www.digicert.com/digicert-root-certificates.htm and apply the certificates to each locked
down workstation manually or by group policy.
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Companion Software Required by SDL Trados Studio
2017

Companion software is the non-SDL software that you may want to have installed on your computer so
that SDL Trados Studio 2017 can function correctly.

Microsoft Office 2007-2016

SDL Trados Studio 2017 fully supports all Microsoft Office 2016, 2013, 2010 and 2007 file formats.

Microsoft Office 2016, 2013, 2010 or 2007 is required to use:
e the Preview features

e Microsoft Word spell-checking.

Microsoft Word 2003 or later

This is needed for processing RTF-based files.
The Real-time preview feature is not available for Click-to-Run versions of Word or for Word 2003.

The Microsoft Excel 2000-2003 file filter converts Microsoft Excel 2000-2003 files to Microsoft Excel 2007
documents on the fly and reconverts them back to Microsoft Excel 2000-2003 after translation. This
speeds up the conversion for Microsoft Excel 2000-2003 documents significantly. For this file type to work
correctly:

e On computers with Microsoft Excel 2000-2003 installed, install the Microsoft Office 2007 compat-
ibility pack available from http://www.microsoft.com/downloads . This will ensure that SDL Trados
Studio 2017 can do the on-the-fly conversion. If the compatibility pack is not installed, the previous,
slower Microsoft Excel 2000-2003 filter will be used.

e On computers with Microsoft Excel 2007 installed, you do not need to do anything. The conversion
will happen in the background.

Upgrading from an Earlier Version of SDL Trados
Studio

You do not have to uninstall an earlier SDL Trados Studio version before installing SDL Trados Studio
2017.

About the SDL Trados Studio 2017 Installer

The installer for SDL Trados Studio 2017 contains the following items:
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SDL Trados Studio 2017

This is the SDL Trados Studio 2017 product.

SDL MultiTerm 2017 settings including SDL
MultiTerm 2017 Core

These enable you to work with SDL MultiTerm
termbases without having SDL MultiTerm Desktop
installed.

Note: SDL MultiTerm Desktop 2017 is not
included in the SDL Trados Studio 2017 installer.
For more information, see the SDL MultiTerm 2017
Installation Guide.

SDL Trados Legacy Compatibility Module for
Studio 2015

This contains S-Tagger for FrameMaker and
S-Tagger for QuickSilver. You can launch these
applications from File > Legacy DTP Formats.

SDL Trados Studio 2017 Apps

There are several SDL AppStore apps included in
the installation.

These are add-ons to enhance the existing Trados
Studio functionality.

Prerequisite software

For Trados Studio 2017 SR1 to work, there are a
number of other pieces of software that need to
be present on your computer. Most of these are
also used by other applications and you probably
have them already. However, if they are not
present, they will be installed automatically. A
complete list of the prerequisite software is given
below.

SDL WorldServer components

The WorldServer components contain the
essential WorldServer resources that enable the
Studio-WorldServer integration.

S-Tagger for FrameMaker

This is a conversion tool, used to prepare FrameMaker MIF files for translation with SDL Translator’s

Workbench, SDL TagEditor and Word.

S-Tagger for QuickSilver

This a conversion tool used to prepare Interleaf IASClI files for translation with SDL Translator’s Work-
bench, SDL TagEditor and Word. Interleaf is part of the QuickSilver XML application suite.

SDL Trados Studio 2017 Apps

These are the SDL AppStore apps that come pre-installed with SDL Trados Studio 2017:

e SDL Batch Find and Replace.
e SDL Plugin Management.

e SDLTTXIT!

e SDL T-Window for Clipboard.

Installation Guide 13
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e SDL XLIFF Converter for Microsoft Office.

Prerequisite Software

The SDL Trados Studio 2017 installer will install the following software, if it is not already present on your
computer:

e Microsoft .NET Framework 4.6.2

e Windows installer 4.5

® Microsoft Visual C++ 2008 Redistributable SP1
® Microsoft Visual C++ 2010 Redistributable

e Microsoft Office 2003 Primary Interop Assemblies (only required if Microsoft Office 2003 is installed
on the computer where SDL Trados Studio is being installed)

e Microsoft Office 2007 Primary Interop Assemblies (only required if Microsoft Office 2007 is installed
on the computer where SDL Trados Studio is being installed)

e Microsoft Web Services Enhancements 2.0 SP3

e Open XML SDK 2.0 for Microsoft Office

Installation Location

The default installation location for SDL Trados Studio 2017 components is:
%programfiles (x86)%\SDL\SDL Trados Studio\Studio5

The Program Files folder on your computer may have a different name if you are using a non- English
operating system.

About the SDL Trados Studio 2017
installation

Installing SDL Trados Studio 2017 involves the following steps:
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Step 1 Install SDL Trados Studio 2017 from your SDL

Acccount. The installer contains a number of
compressed files which Trados Studio
decompresses when you start the installation.
Next, the actual installation takes place.

Step 2 Once installed, you can start SDL Trados Studio

2017.The Product Activation dialog box is
displayed. Here you can activate your product or
choose to use the 30 days trial. The trial license
runs SDL Trados Studio in Professional mode for
30 days. At the end of 30 days you must activate
your own license. If you do not have a valid license
at that time, you can no longer use Studio. If you
have purchased a Freelance, Starter or Express
license, you may want to take advantage of the
trial license as it will give you access to more
functionality than your own license. For more
information, see theStudio Editions section.

If you downloaded the software from your SDL Acccount > Products & Plan, go to the location
where you stored the downloaded files and run the installer from there.

If you are installing the software from a network resource, ask your system administrator for the
network location of the SDL Trados Studio 2017 installer setup program.

Installing SDL Trados Studio 2017

The installation routine for SDL Trados Studio 2017 is based on an installation wizard which guides you
through the process.

About this task

e Toinstall SDL Trados Studio 2017, you must have local administrator rights on your computer.

e The installer also supports administrative and silent installations. You can find instructions for

administrative and silent installations in the Studio Enterprise Deployment Guide which is available
from SDL Customer Support. For information on how to contact Customer Support, see https://
gateway.sdl.com.

Before You Start
To install SDL Trados Studio 2017:

Procedure

1.

In the Downloads area of the SDL Account website, select Download next to SDL Trados Studio
2017:

L!, Alternative download vig FTP

Click Run to download the self-extracting installation executable file.
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Note: If you encounter any problems downloading the file, select Alternative download via FTP
to download the file from an FTP side instead. When all of the installation files have been decom-
pressed, the first page of the SDL Trados Studio 2017 SDL Trados Studio 2017 installer is displayed.

E 5DL Trades Studio 2017 5R1 — >

This will install SDL Trados Studio 2017 . Once

you have activated your license, the application will
run in the Edition mode matching your activation
code (for instance, Freelance or Professional). You
can always check the current Edition mode in Help
About. If you are installing this product for the first
time, a 30-day trial of the Professional version will be
installed for you automatically.

The contents of this package will be decompressed
and then the installation process will begin.

I Accept | | Decline

3. Click Accept. The installer files are extracted to your computer. When all of the installer files have
been extracted, the License Agreement page is displayed.

Note: If you do not have Microsoft .NET Framework 4.6.2 and Windows installer 4.5 installed, these
are installed now and you may be asked to restart your computer.
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6.

%] SDL Trados Studie 2017 - O x

Please wait while setup configures the following components as required.

Action
':'ﬂ::' Checking conditions
o Installing Suite repair utility
@ Instaling Microscft Visual C++ 2008 Redistributable SP1
o Installing Microsoft Visual C++ 2010 Redistributable
& Installing Microsoft Visual C++ 2013 Redistibutable
&) Instaling Microsoft Office 2003 Primary Interop Assemblies
(‘-‘l::' Installing Microsoft Office 2007 Primary Interop Assemblies
& Instaling Licensing Inttialization Ltility
® Installing SOL WordServer Components
Instaling SDL Trades Legacy Compatibility Module
Installing SDL Trados Studio 2017 SR1
Deleting older versions of SDL Trados Studio 2017

Copying new files

Accept the license agreement and click Next.
A screen listing all of the components that will be installed is displayed.

The installer installs the components and indicates the progress of the installation.

.3 SDL Trados Studio 2015 = o |

Please wait while setup configures the following components as required.

Action
@ Checking conditions
@ Installing Suite repair Ltility
@ Installing Microsoft Visual C++ 2008 Redistributable SP1
@ Installing Microsoft Visual C++ 2010 Redistributable
@ Installing Microsoft Office 2003 Primary Interop Assemblies
@ Installing Microsoft Cffice 2007 Primary Interop Assemblies
@ Installing Licensing Intialization Liility
@ Installing Open XML SDK 2.0 for Microsoft Office
@ Installing Microsoft Web Services Enhancements 2.0 5P3
(& Installing SDL WordServer Components
@ Installing SOL Trados Legacy Compatibility Module

Installing SOL Trados Studio 2015

Wiriting system registry values

Installing 5DL Trados Legacy Compatibility Module

When the installation is complete, a confirmation dialog box is displayed. Click OK.
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o Setup has completed successfully,

oK

SDL Trados Studio 2017 is now added to the Start menu underSDL Trados Studio 2017..

After Installation

When you first start SDL Trados Studio, the following windows help you set up SDL Trados Studio for
first time use: Product Activation and SDL Trados Studio Setup Wizard.

1. The Product Activation dialog, where you can activate SDL Trados Studio or choose to use the 30
days trial. For more information on licensing SDL Trados Studio , click the Help button on this dialog
or go to the SDL Licensing Help.

2. The SDL Trados Studio Setup wizard, where you can:

a. Specify your user details for this instance of SDL Trados Studio .

SDL Trados Studio Setup

X
Current User Details .
-

Please specify the cument user details.

MName: |

Phone Mumber: |

|
Email Addrezs: | |
|
|

TM UserID:  |[GLOBAL\

Description:

Help < Back Mext » Finish Cancel

b. Specify your user profile for this instance of SDL Trados Studio .
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SDL Trades Studio Setup *

User Profile
Flease select the user profile that best matches your needs.

Pleaze select a user profile:
Default ~ Browse...

User profile description:

|ser profile recommended for new users.

Help < Back Meadt = Finigh Cancel

Start participating in the SDL Customer Experience Improvement Program.

SDL Trados Studio Setup *

Help Improve the SDL Trados Studic Experience

Join the SDL Customer Experience Improvement Program to help improve the gualty, reliability and
performance of S0L software.

if you choose to join, SDL will collect anonymous information to understand how you use SDL Trados Studio.
SOL will not
» Collect any content you process, neither in the source nor target languages with which you work.

s Caollect any content from your translation memaries or terminology databases.
» Collect your name, address or any other personally identifiable information.

» Ask you to take surveys or contact you for a sale.

» Prompt additional messages that might intermupt your wark.

s Decrease your software's peformance.

Read our Privacy Policy

You can stop participating in this program at any time. To opt out, click Help > Customer Feedback > No, | do not want to
join.

(® Yes. | want to join and help make Studio even better frecommended).

() Mo, | do not want to join.

Help < Back Mext > Finigh Cancel
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d. Load asample project in order to explore the SDL Trados Studio functionality at startup.

SDL Trados Studio Setup >

Samples

Please select whether you want to load sample files and documentation .

SDL Trados Studio comes with @ number of sample files which aim to get you started quickly, whether you are a new user or
whether you have used SDL Trados products befare.

Load samples at initial startup

Mote: the samples will be accessible at any time even if you choose not do this right now.

Help < Back Next > Cancel

3. The Language Cloud wizard where you can connect SDL Trados Studio with SDL Language Cloud.
This gives you access to SDL AdaptiveMT (self-learning machine translation) engines from within SDL
Trados Studio . Use your SDL Account credentials to sign up to Language Cloud and activate the
30 days free trial.

Logging an Installation

The installation is logged automatically. Log files are created here:

%ALLUSERSPROFILE%\Application Data\SDL\Chainer\Logs

Software updates

Some software updates to the application can be downloaded from within SDL Trados Studio or software
updates can be automatically checked for and downloaded when SDL Trados Studio is started.

You can specify how you want SDL Trados Studio to detect application updates or your system adminis-
trator can specify a group policy for all users.

20 Installation Guide



Installing SDL Trados Studio 2017 @

Temporary directory

Software updates are downloaded to the following temporary directory:
%temp%\studioS5updates

After the update is installed, you can delete the files from this location.

Individual User Software Updates

An individual user of SDL Trados Studio can do the following:

e Specify that they want to check for software updates when SDL Trados Studio starts. They can do
this on the Automatic Updates page of the Options dialog box.

e Manually check for updates by selecting Help > Check for Updates from the ribbon in SDL Trados
Studio.

Note: If either of these options is unavailable, the system administrator has set a group policy that
enables or disables checking for software updates

Group Policy Software Updates

SDL Trados Studio includes a feature that notifies users of the availability of software updates and gives
them the option to install the updates on their own computer. The system administrator can set a group
policy that controls the way this feature works. You can choose to:

About this task

e Enable automatic checking for updates. When you choose this option, an automatic check for
updates is made every time a user starts the application. When an update is available, the user is
prompted to apply the update to their installation.

e Enable user control of checking for updates. When you choose this option, the users can enable
automatic checks for updates (these take place whenever the application is started) and they can
also check for updates manually at any time. When an update is available, the user is prompted to
apply the update to their installation.

e Disable all checks. This option means that automatic checks for updates will not be performed and
users cannot perform manual checks either. You should choose this option if you want to control the
application of updates centrally.

You define a group policy by configuring the Studio5AutoUpdate.adm file in the Group Policy dialog
box.

To define a group policy (note that the screenshots here may vary slightly, depending on the operating
system that you are using):

Installation Guide 21



@ Installing SDL Trados Studio 2017

Procedure

1.

Locate the ADM file. The file name is:Studio5AutoUpdate. adm
The default location for this file is:
$ALLUSERSPROFILE%\Package Cache\SDL\SDLTradosStudio2017

2. Select start > Run and enter the following command:

gpedit.msc

3. The Group Policy dialog box is displayed. Right-click on Computer Configuration > Adminis-
trative Templates and select Add/Remove Templates from the shortcut menu.

File Action View Help

e | 2E = HEl7T

‘=] Local Computer Policy - - s

omputer Configuration 7
| Software Settings Select an itemn to view its description.  Setting State

Windows Settings _ Control Panel

« (B Sdoinistiative ==
i+ (-] Centrol Pa Add/Remove Templates.., = pi 38
1 [ Network Eheron . Sﬂ:tters
| Printers Filter Onti | System
[ System SR | Windows Components
b 1] Windows Re-Apply Filter 5 All Settings
o AllSeting: ) Tasks »
a 4 User Configuratio
1 [ Software Setti View 3
1+ [ Windows Setti -
b 07 Administrative  EPertListe
Help

'\ Extended /{Standard/

Filter On

4. The Add/Remove Templates dialog box is displayed. Click Add and browse to the location of the

Studio5AutoUpdate.adm file.
r —_— = ™
Add/Remove Templates ﬁ

Cumrent Policy Templates:

MName Size  Modfied

5. Click Close when the template is added.

6. Computer Configuration > Administrative Templates > Classic Administrative
Templates (ADM) > SDL Applications > SDL Trados Studio v3 is added to the navigation
tree. Select SDL Trados Studio to display its settings on the right.
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7.
8.

Double-click on the Enable Autoupdate setting.

The Enable Autoupdate dialog box is displayed. Select one of the following options and click OK
to save the group policy:

e Not Configured - The user can choose to enable or disable checking for application updates
automatically when the application starts and can also manually check for application updates.

e Enabled - SDL Trados Studio checks for updates automatically when the application starts. The
user cannot disable the automatic updates option. The user can also manually check for
application updates.

e Disabled - Automatic checks for application updates and manual checks for updates are
disabled. The user cannot enable either of these options.

Enable Autoupdate

@ Mot Configured Comment: -
(71 Enabled

(7 Disabled L hill
Supported on:

Options: Help:
When enabled, the application will check for updates -
autornatically. The user may still cancel the update if one is
available,

When disabled, the application will not check for updates, neither
automatically nor from the Help menu.

When this policy is applied, the user's preference in the
application is overriden and cannot be changed in the interface.
When the policy is not configured, the user can check for updates
from the Help menu and they can set whether or not updates are
automatically checked for in the application's settings.
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Logging a Software Update

The update is logged automatically. There are two log files that are created.

The first log file is created when checking for updates and downloading installer for the update. This log
file is located here:

%ProgramData%\SDL\SDL Trados Studio\Studio5\Updates
The other log file is created during the installation of the update and is located here:

%temp%\studioS5updates

Removing your Software Update

If you encounter any problems after updating your software, you can remove the update.

To remove your software update:

1. From the Start menu on your computer, choose Panel Settings > Control.

2. Inthe Control Panel, select Add or Remove Programs or Programs and Features.
3. Ensure that the Show updates option is selected.

4. Select the software update from the list of programs and click Remove.

5

Follow the on-screen instructions to remove the software update.

Note: In addition to removing the update, clear the Automatically check for updates when the
application starts check box on the Automatic Updates page of the Options dialog box. This
disables the option and prevents the installation of the update again.

Maintaining Your Installation

You can repair or remove your SDL Trados Studio 2017 installation at any time.

Repairing your SDL Trados Studio 2017 Installation

Use the repair feature to repair or restore missing files or registry entries in your installation.

About this task
To repair your installation:
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Procedure
1. From the Start menu on your computer, select Control Panel.
2. In the Control Panel, select Programs > Uninstall a Program.

3. Select SDL Trados Studio 2017 from the list of programs and click Repair. This starts the Windows
Installer which runs the repair process.

4. When the process is complete, click Finish.

Repeat for MT Core and Trados Studio Compatibility if applicable.

Removing SDL Trados Studio 2017

Before uninstalling, we recommend that you deactivate your product license. To do this, call up Help >
Product Activation in the application.

About this task
To uninstall:

Procedure

1. From the Start menu on your computer, choose Control Panel.
2. Inthe Control Panel, select Uninstall a Program.

3. Select:

e SDL Trados Studio 2017 - Remove suite of products from the list of programs to remove SDL
Trados Studio 2017 and all of the components installed with the application. See the About the
SDL Trados Studio 2017 Installer section for a list of the components installed with SDL
Trados Studio 2017.

e SDL Trados Studio 2017 from the list of programs to remove only the SDL Trados Studio 2017
application.

4. Choose Remove or Uninstall as appropriate.

Customer support

To contact Technical Support, connect to the Customer Support Web Portal at https://gateway.sdl.com
and log a case for your SDL product. You need an account to log a case. If you do not have an account,
contact your company's SDL Support Account Administrator.

What's Next?

The instructions in the SDL Trados Studio Video Help Series and the Quick Start Guides will quickly
get you started with SDL Trados Studio.

You can access these and more helpful resources athttps://docs.sdl.com/ SDLTradosStudio2017.

If you have some existing translation resources, translation memories for example, you should migrate
them to the SDL Trados Studio 2017 format. Converting or upgrading existing translation resources so
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that you can work with them in SDL Trados Studio 2017 is described in the SDL Trados Studio 2017
Migration Guide.
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SDL Trados Studio includes open source or similar third-party software.

#ziplib
#ziplib (SharpZipLib, formerly NZipLib) is a Zip, GZip, Tar and BZip2 library written entirely in Ci# for
the .NET platform. It is implemented as an assembly (installable in the GAC), and thus can easily be
incorporated into other projects (in any .NET language).

Apache log4net
The Apache log4net library is a tool to help the programmer output log statements to a variety of
output targets. log4net is a port of the Apache log4j™ framework to the Microsoft® .NET runtime.

Hunspell
Hunspell is the spell checker of LibreOffice, OpenOffice.org, Mozilla Firefox 3 & Thunderbird, Google
Chrome, and it is also used by proprietary software packages, like Mac OS X, InDesign, MemoQ, Opera
and SDL Trados Studio.

ICU (International Components for Unicode)
ICU is a mature, widely used set of C/C++ and Java libraries providing Unicode and Globalization
support for software applications. ICU is widely portable and gives applications the same results on
all platforms and between C/C++ and Java software.

SafeNet Sentinel
SafeNet's Sentinel software licensing products and software protection solutions provides software
publishers control and visibility into how their applications are deployed and used.

Spring.NET
Spring.NET is an application framework that provides comprehensive infrastructural support for
developing enterprise .NET applications. It allows you to remove incidental complexity when using
the base class libraries makes best practices, such as test driven development, easy practices.

wix
The WiX toolset builds Windows installation packages from XML source code. The tool-set integrates
seamlessly into build processes.

Xerces-C++
Xerces-C++ is a validating XML parser written in a portable subset of C++.
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SDL (LSE:SDL) is the global innovator in language translation technology, services and content
management. With more than 20 years of experience, SDL delivers transformative business results by
enabling powerfully nuanced digital experiences with customers around the world.
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